CETR

UMT-2
Multi-Specimen Test System

Software Operating Manual

Version 1.77
Build 139

1/26/04
# Table of Contents

1 Starting the UMT-2 System Software .................................................. 3

1.1 Menu Bar .................................................................................. 3

1.1.1 File .................................................................................. 3

1.1.2 Edit .................................................................................. 4

1.1.3 View .................................................................................. 4

1.1.4 Script ................................................................................ 4

1.1.5 Run .................................................................................... 5

1.1.6 Tools .................................................................................. 5

1.1.7 Options ............................................................................. 6

1.1.8 Window ............................................................................ 6

1.1.9 Help ..................................................................................6

1.2 Tool Bar .................................................................................. 6

1.3 Status Bar .............................................................................. 7

2 Creating New Test Scripts ............................................................. 7

2.1 Sequence Menu Tabs .................................................................. 7

2.1.1 Engage (Sequence Menu) ..................................................... 8

2.1.2 Test (Sequence Menu) ......................................................... 8

2.1.3 Disengage (Sequence Menu) .............................................. 9

2.1.4 Data File (Sequence Menu) ............................................... 9

2.1.5 Notes (Sequence Menu) .................................................... 10

2.2 Sheet Menu Tabs ..................................................................... 10

2.2.1 Carriage (Sheet Menu) ...................................................... 10

2.2.2 Spindle (Sheet Menu) ......................................................... 13

2.2.3 Slider (Sheet Menu) ........................................................... 13

2.2.4 Heater (Sheet Menu) ........................................................ 14

2.2.5 Notes (Sheet Menu) .......................................................... 14

3 Starting an Automatic Test ............................................................ 15

4 Automatic Panel command ............................................................ 16

4.1 Selecting Multiple Panels ......................................................... 16

4.2 Automatic Panel Appearance .................................................. 17

5 Semiautomatic Panel command ..................................................... 18

5.1 Carriage .................................................................................. 18

5.2 Spindle ................................................................................... 18

5.3 Slider ..................................................................................... 19

5.4 Heater ..................................................................................... 19

5.5 Data-I ....................................................................................... 20

5.6 Data-II .................................................................................... 20

5.7 Blackbox ................................................................................ 20
1 Starting the UMT-2 System Software

Make sure that the UMT-2 testing block is turned on. From the Windows desktop, double-click the CETR icon labeled Umt.exe (shown on the left). Initially, the UMT program main screen is blank except for the Menu bar, Tool bar, and Status bar.

UMT Main Screen

1.1 Menu Bar

Each item on the Menu Bar calls up a drop-down menu of commands. All Menu and Tool Bar commands are active only if they executable in a current window. Inactive commands are shaded. Some Menu Bar commands are duplicated on the Tool Bar.

1.1.1 File

The File command allows you to start a new test script (New), open a previously saved test script (Open), save the current test script (Save or Save As), print a selected test script or all listed scripts (Print), or exit the UMT program (Exit). Test scripts are described under Script.
1.1.2 Edit

The Edit command allows you to Cut, Copy, and Paste sections of the current test script.

1.1.3 View

The View menu enables or hides portions of the display screen. A check enables and no check hides.

1.1.4 Script

The Script menu allows you to start a new test script, open a saved test script, or close the current test script. You can edit the current test script by adding a new sequence, adding a sheet or deleting a sheet.

The Preview Script command displays a message window listing any rules violations or conflicts in the script.

1.1.5 Run

The Run menu allows you to start, pause, or stop a test sequence.

The Sensor Bias command becomes active only if the window related to a sensor is active. It uses the current value of the selected channel as the zero offset value. To ensure accurate and repeatable results, the sensors must be biased at the beginning of every test.

The Channel Unbias command removes the bias only from the selected channel.

The Sensor Unbias command removes the bias from all channels.
The **Position Reset** command sets the current position of the selected motor to zero. The items in the **Run** menu correspond to the segment of the Tool Bar illustrated below.

![Tool Bar Menu](image)

### 1.1.6 Tools

The **Terminal** command allows direct communication with controller serial ports. This function requires the use of command language unique to the motor controllers and is covered in the controller manufacturers manual.

The **Viewer** command accesses the data retrieval software which is independent of the software used to acquire and store data and control the operation of the UMT-2 test system. See the **Viewer** manual for details.

**Heater Auto-Tuning** is enabled when the heater controller is turned on and either the Graphs Panel or the Semi-Automatic Panel is selected. Auto tuning adjusts the response of the heater controller to minimize error. The target temperature must be at least 15 degrees greater than the current temperature or else an error message will appear. Auto tuning takes a few minutes to complete. The display on the heater controller when auto tuning is active.

### 1.1.7 Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Opens the hardware configuration file for viewing or editing</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the hardware configuration using the same file name</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Saves the current hardware configuration to a specified file name</td>
</tr>
<tr>
<td><strong>Load</strong></td>
<td>Loads option file of hardware configuration</td>
</tr>
</tbody>
</table>

Use the **Edit** command in the **Options** menu to read or edit the hardware configuration such as availability of the following options: **Carriage**, **Spindle**, **Slider** and **Heater**. A detailed description of all the menus in the hardware configuration file is given under **Options** menu.
1.1.8 Window

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td>Creates a new window that views the same document.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Arranges windows in an overlapped fashion.</td>
</tr>
<tr>
<td>Tile</td>
<td>Arranges windows in non-overlapped tiles.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges icons of closed windows.</td>
</tr>
<tr>
<td>Synchronize Graphs</td>
<td>Synchronizes Graphs</td>
</tr>
</tbody>
</table>

Use the **New Window** command to open a new window with the same contents as the active window. You can open multiple document windows to display different parts or views of a document at the same time. If you change the contents in one window, all other windows containing the same document reflect those changes. When you open a new window, it becomes the active window and is displayed on top of all other open windows.

Use the **Arrange Icons** command to arrange the icons for minimized windows at the bottom of the main window. If there is an open document window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this document window.

1.1.9 Help

There is no on screen Help. Refer to this manual for help. Use the **About** command to display the copyright notice and version number of your copy of the UMT program. The CETR website can be accessed if the computer is connected to the Internet.

1.2 Tool Bar

The Tool Bar has the commands you use most often so you can find and use them quickly. The commands are taken from the Menu Bar. The illustration below shows the tool bar with the functions listed below it and the corresponding Menu Bar commands listed above it.

<table>
<thead>
<tr>
<th>Files</th>
<th>Edit</th>
<th>Script</th>
<th>View</th>
<th>Run</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create a new script file</strong></td>
<td><strong>Open a script file</strong></td>
<td><strong>Copy</strong></td>
<td><strong>Paste</strong></td>
<td><strong>Add a sequence</strong></td>
</tr>
</tbody>
</table>

Create a new script file
Open a script file
Copy
Paste
Add a sequence
Display Automatic Panel
Display position control panel
Display Data Viewer
Set position to zero
Manually set position
Go to Home position
Zero all sensors
Zero selected channel
Unbias all sensors
Clear data display trace
Zero Analog Encoder
Run
Pause
Stop
Help
1.3 Status Bar

The status bar is displayed at the bottom of the UMT program window. To display or hide the status bar, use the Status Bar command in the View menu. The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them. If after viewing the description of the toolbar button command you wish not to execute the command, then release the mouse button while the pointer is off the toolbar button. The right areas of the status bar indicate the state of the test in progress. See Starting an Automatic Test.

2 Creating New Test Scripts

Test scripts control the automatic sequencing of the UMT mechanics and data acquisition and storage. A new test script can be created any one of three ways - select the File command from the Menu Bar and then New, click the left-most button on the Tool Bar, or Select the Script command from the Menu Bar and then New script. In any case the New Sequence window will appear. Enter a name for the first sequence in the script. It should be a name that relates what the sequence does such as scratch test. Next enter the number of sheets that will be in the sequence. Sheets can be added or deleted later as needed. click OK.

![New Sequence Window]

A test script is a series of Sequences, and within a sequence are a number of Sheets. Each sequence is a loop which will be performed as few times as once or as many times as 100,000.

2.1 Sequence Menu Tabs

The tabs that appear when a Sequence is highlighted define the overall sequence. Sequences with a check in the box next to them will be performed, and sequences without a check will be skipped. The test will begin with the first checked sequence when the Run button is clicked.

To print out of a Sequence including all the Sheets click the right mouse button on the word Sequence and then click on print.
2.1.1 Engage (Sequence Menu)
The Engage parameters control the action of the tester at the beginning of the test when the upper specimen is first lowered and brought into contact with the lower specimen. In the example below the carriage will descend at Pretouch velocity of 0.5 mm/sec. until the upper and lower specimens touch each other and the Force (Fz) exceeds 0.1 Newton. Then the carriage will slow to the Touch velocity of 0.05 mm/sec. until 5N (the first force in the first sheet) is reached. Any farther movement will be at the Near velocity of 0.01 mm/sec. The Far, Touch and Near velocities should be in decreasing order although Touch and Near can be equal. If the Move to Home Position box is checked the carriage will first move to the home position and then to the lower specimen. If the Zero Encoder box is checked the carriage position will set to zero. The acceleration and deceleration times are programmed by entering the appropriate value under Spindle Accel/Deccel time. Spindle 1 is the lower drive, and Spindle 2 is the upper rotational drive found mostly on the PMT and CMP versions of the UMT.

2.1.2 Test (Sequence Menu)
The Test parameters control the action of the carriage during the Sheets portion of the sequence. If the Positive tolerance is exceeded the carriage will move downward, and If the Negative tolerance is exceeded the carriage will move upward to maintain the desired loading (Fz). A Tracking Filter is used to smooth out the force input data that is used by the carriage positioning system to control Fz. The Size is the number of samples to be used to calculate a running average. The Repeat Current Sequence value is the number of time the sequence will loop through the Sheets within the current sequence. Time-Out is used to stop the sequence if it does not advance within the
given time. For example, if the sequence does not advance from Engage to Test within 300 seconds the test will stop and a message will appear. **Conditions for ending test** uses logical expressions (i.e. <, >, and, or) to set conditions whereby the test skips to the next sheet, skips to the next sequence or ends the test.

2.1.3 **Disengage** (Sequence Menu)

The **Disengage** parameters control the retraction of the carriage at the very end of a test. Because of this, only the last **Disengage** tab of the last checked (enabled) sequence in a script is active. Any previous to that are ignored. How far the carriage retracts is entered in **Distance**, and how fast it retracts is entered in **Velocity**. If the **Move to Home Position** box is checked the carriage will move to the home position. If the **Zero Encoder** box is checked the carriage position will set to zero.

2.1.4 **Data File** (Sequence Menu)

The **Data File** tab defines the File Name where test data is to be saved. **Data will only be saved if Create Data File file is checked.** Each sequence in a script has its own data file. The sensor **Channels** that are to be used during the sequence must be checked. The number in the box labeled **Save every Nth Reading** refers to the sampled data points. In this example every 100th data point would be saved for Fx and Fz in the file called iScratch01.tst. If **Average** had been selected the average of every 100 data points would be saved. Saved data files can be plotted using the Data File viewer program. Plots are selected by channel and Sheet. **Operator's Comments** can be added after the test is completed. Click on the Save Comments button after entering the comments. The comments will be saved with the data. When a data file that has comments is selected with the Viewer program an envelope icon will be high-lighted indicating the presents of a comment. The comments can be displayed by clicking on the envelope.
2.1.5 Notes (Sequence Menu)

This tab provides a place for storing notes pertaining to the sequence, the setup or the environment. The notes are for documentation purposes only and do not effect any parameters or data. They do not appear anywhere but here.

2.2 Sheet Menu Tabs

When a sheet is selected in the sequence the Sheet Menu appears. The tabs that appear when a Sheet is highlighted define the steps within the sequence. To print out a single Sheet select the sheet and click the right mouse button, then click on print.

2.2.1 Carriage (Sheet Menu)

The Carriage tab defines the action of the carriage during the Test portion of the sequence. In the example the Force is set to 55 Newton. This is the force that ended the Engage portion of the sequence.

With Constant Force: selected the carriage will move up and down as necessary to maintain a constant force (in this case 5 Newton). The Pull Test box is checked only when the Fz force is in the upward direction such adhesion or tensile strength tests. The Duration of this part of the sequence is set to 10 seconds. The After Test function is usually enabled on the last sheet of the last sequence. If Move carriage up is checked the carriage will retract to the set distance at the end of this part of the sequence. If the Bias sensors box is checked the force/load sensors will be zeroed after the carriage moves up. When the carriage is retracted there is no load on the sensors and their outputs should represent zero force. If the Write data box is checked data will be collected during the carriage retraction, otherwise it will not. Saving the data during retraction is useful for stiction or adhesion measurements. For testers equipped with the analog encoder option, if the Reset Encoders box is checked the analog encoder readings will be zeroed at the end of the current sheet. This can also be done at any time clicking the Reset Encoders button on the Tool Bar.
When **Linear Force (Fz) by Time** is selected the force will change linearly from the **From** value to the **To** value in the **Duration** time. This mode is often used to determine critical load.

When **Linear Force (Fz) by Spindle Position** is selected the force will change linearly from the **From** value to the **To** value while the spindle rotates a fixed **Distance** in the **Increment** mode. See **Spindle (Sheet Menu)**.

When **Force Cycles** is selected the force will change linearly from the **From** value to the **To** value and back to the **From** value for the number of **Cycles** during each spindle revolution.

When **Absolute Carriage Displacement** is selected the carriage will move to the **From** position with the **Initial positioning** velocity before the **Duration** time begins, and then to the **To** position with the **Working** velocity during the **Duration** time.
When **Increment Carriage Displacement** is selected the carriage will move by the **Offset** distance with the **Working** velocity from its current position. When **Up or Down Direction** selected the carriage will make a single move in the selected direction. When **Cycle** is selected the carriage will continuously move up and down by the **Offset** distance during the **Duration** time.

When **Sinusoidal Force by Time** is selected the force (Fz) is applied as a sine wave about the **Mean** value. The **Magnitude** of the sine wave is the **Mean** to peak value. When the **Magnitude** has a negative value the first cycle will begin in the negative direction. The **Frequency** of the sine wave should not exceed 1 Hz. The force is applied for the **Duration** time.

When **User-defined Force (Fz) by Time** is selected the force is applied according to a profile defined in a user generated look-up table. The look-up table is an ASCII text file with a column of number that defines the curvature of the profile. The **Abs. Min.** and **Abs. Max.** define the force range of the profile, and **Duration** defines the time length of the profile. Click on **Force Profile** to display the current profile.
2.2.2 **Spindle (Sheet Menu)**

If **Move - Continuous** is checked the spindle will spin up to the value entered in **Velocity** in the amount of time entered in **Sequence-Engage-Accel/Decel time** at the end of the **Engage** portion of the sequence. If the velocity is in mm/min or inch/min the position of the slider will be used to calculate the spindle speed to achieve the proper linear velocity. The spindle will spin in the selected **Direction** for the **Duration** entered under **Sheet-Carriage**.

If **Increment** is checked the spindle will rotate the set **Distance** at the set **Velocity**. If **Cycle** is selected the spindle will cycle between cw and ccw by the set **Distance** at the set **Velocity** for the **Duration** entered under **Sheet-Carriage**. The **Distance** and **Velocity** should be selected so as not to exceed the **Duration**.

If the **Move Immediately** box is checked the spindle will start to rotate as soon as the Run button is clicked.

2.2.3 **Slider (Sheet Menu)**

**Idle Position**

Selecting **Idle** enables the **Initial** window. The value in this window is the position in mm or inches to which the slider will travel at the beginning of this segment of the test. It will move at the rate set in the **Velocity (initial positioning)** window. Positive values of position are to the left of zero.

**Absolute Position**

Selecting **Absolute** enables the **Final** window. The value in this window is the position to which the slider will travel from the **Initial** position during this segment of the test. It will move at the rate set in the **Velocity (working)** window. If **Manual** is selected the working velocity may be entered in the window, but if **Automatic** is selected the working velocity is computed so that the slider moves from the **Initial** position to the **Final** position in the time set under **Carriage-Duration**.
Increment Position
Selecting Increment enables the Offset window. The value in this window is the distance that the slider will travel from its current position during this segment of the test. It will move in the selected Direction at the rate set in the Velocity (working) window. If Cycle is selected the slider will move back and forth at the Offset distance at the working velocity for the time set under Carriage-Duration. The Manual Velocity setting must be selected to enable Cycle.

2.2.4 Heater (Sheet Menu)
This tab will only appear if Heater is checked in the options file under Motorized Specimens. When the Use Heater box is checked and the sequence reaches this sheet the temperature in the temperature chamber change from its current temperature to the Set Temperature. If the Heat in Test Time is selected the temperature will change in the Duration time in the Carriage tab provided that the duration is long enough. If Heat with maximum Speed is selected the temperature will change at 15° C per minute.

2.2.5 Notes (Sheet Menu)
This tab provides a place for storing notes pertaining to this sheet. The notes are for documentation purposes only and do not effect any parameters or data. They do not appear anywhere but here.
3 Starting an Automatic Test

Select a script from the File menu. If the script has multiple sequences check the box next to the sequences that are to be performed. Click on the Run button on the Tool Bar. A dialog box will appear asking for the number of iterations or the number of times the checked sequences in the script will be repeated. In the example to the left all the checked sequences would be run in order and then repeated a second time.

After the iterations are entered, and OK is clicked, the Automatic Panel will appear. The Status Bar at the bottom of the screen will first displays Standby and then Engage as the carriage moves down to make contact between the upper and lower specimens.

The numbers in the second box indicate the current part of the test script that is in process. The numbers are as follows: Iteration number, Sequence number, loop number, and Sheet number.

At the end of the Engage phase the Status Bar will display Test, the Timer box will show the time remaining for the current sheet, and the Automatic Panel will display plots of the sensors.

When all the iterations of the script are complete the Status Bar will display Disengage as the carriage moves up and then Standby indicating the end of the test.
4 Automatic Panel command

The Automatic Panel (Graphs Panel) appears when a test is started. It may also be selected by going to the View menu and clicking on Automatic Panel or by clicking on the Graphs Panel button on the Tool Bar. During the running of a test sequence a real time graph will be displayed in the Automatic panel. Up nine different panels may be displayed at the same time. Each panel can display a number of pre-selected channels.

4.1 Selecting Multiple Panels

Clicking the Automatic Panel button after the first panel is displayed enables the panel selection menu.

This is the same menu that appears in the Options menu under Graphs (Section 6.3.1). Select the next panel to be displayed by clicking on the appropriate channel under Topics and then click OK.
4.2 Automatic Panel Appearance

The appearance of each panel can be customized by double clicking on labels, titles, axis, and legends. For example, if you double click on the x axis title the Test Parameters screen appears. With this screen you can change the text, font, color, and size of the x axis title.

If you double click on the x-axis label the Axis Label screen appears. With this screen you can change position and format of the axis label. Click on Text Parameters and you can change the appearance of the text.

If you double click on the x-axis scale the Horizontal Axis screen appears. With this screen you can change the range, the y axis intercept, the grid and line type.

If you double click on the numbers to the right of the legend the Dynamic Text screen appears.
5 Semiautomatic Panel command

The Semiautomatic Panel can be accessed by going to the View command on the Menu Bar and selecting Semiautomatic Panel or more directly by clicking on the Semiautomatic Panel button on the Tool Bar. The Semiautomatic Panel allows you to control the carriage, spindle, slider and data acquisition channels one step at a time rather than a fully automatic test sequence.

5.1 Carriage

Select the Carriage tab (the vertical positioning system for the upper specimen) to set the following parameters: Velocity, Distance in millimeters and Direction. The current carriage Position is displayed. The Rate display indicates the number of command responses per second received from the carriage motor controller. When the Carriage tab is selected the Reset, Set Distance, Run, Pause and Stop buttons on the Tool Bar become enabled. Clicking on the Reset button sets the current carriage position to zero. Clicking on the Set Distance button sets the current carriage position to value entered in the Distance window. Clicking on the Run button will cause the carriage to move the specified distance in the specified direction at the specified velocity. If Cycle is selected the carriage will cycle down and up the specified distance until the Stop button is clicked.

5.2 Spindle

Click on the Spindle tab (the rotating positioning system for the lower specimen) to set the following parameters: Velocity in rev/min, mm/min or inch/min, Direction: Clockwise or Counter Clockwise. When Increment is selected the Distance in revolutions can be set. The spindle Position is displayed. The Rate display indicates the number of command responses per second received from the spindle motor controller.
When the **Spindle** tab is selected the Motor Reset, Run, Pause and Stop buttons on the Tool Bar become enabled. Clicking on the Motor Reset button sets the current spindle position to zero. Clicking on the Run button will cause the spindle to rotate the specified distance in the specified direction at the specified velocity when **Increment** is selected. If **Continuous** is selected the spindle will rotate continuously in the specified direction at the specified velocity until the Pause or Stop button is clicked.

### 5.3 Slider

Click on the **Slider** tab (the horizontal positioning system for the upper specimen) to set the following parameters: **Velocity** in mm/sec, **Direction**: Right or Left. The slider **Position** is displayed. The **Rate** display indicates the number of command responses per second received from the slider motor controller. When the **Slider** tab is selected the **Reset**, **Set Distance**, **Run**, **Pause** and **Stop** buttons on the Tool Bar become enabled.

Clicking on the **Reset** button sets the current Slider position to zero. Clicking on the **Set Distance** button sets the current Slider position to value entered in the **Distance** window. Clicking on the **Run** button will cause the Slider to move the specified distance in the specified direction at the specified velocity. If **Cycle** is selected the Slider will cycle left and right the specified distance until the **Stop** button is clicked.

### 5.4 Heater

The heating chamber can be controlled and monitored in the Semi-automatic mode. The current temperature is displayed in the **Temperature** window. The sampling rate in samples per second is displayed in the **Rate** window. Enter the desired **Heating Temperature** and **Heating Time** in the corresponding windows and click on the **Set** button. The maximum heating rate is 15°C. The heater will ramp to the set temperature in the set time. Click on the **Standby** button to turn the heater off.
5.5 Data-I

In the Data-I tab the current Force (Fx, Fy, Fz) and Torque (Tx, Ty, Tz) are displayed. The sample rate of the first data acquisition board is displayed in the Rate1= window. If there are two data acquisition boards the sample rate of the second data acquisition board is displayed in the Rate2= window. The Bias All and Unbias All buttons are enabled allowing all channels to be set to zero or returned to their unbiased value. If the elevated temperature option is present is current temperature in the temperature chamber will be displayed in this tab.

5.6 Data-II

In the Data-II tab the current value of input channels 1 through 6 are displayed. These are most often used for Temperature, Resistance and Acoustic Emission channels. The sample rate of the first data acquisition board is displayed in the Rate1= window. If there are two data acquisition boards the sample rate of the second data acquisition board is displayed in the Rate2= window. If the elevated temperature option is present is current temperature in the temperature chamber will be displayed in this tab.

5.7 Blackbox

To store data while using the Semiautomatic Panel click on Blackbox, enter File Name, select Channels to be recorded and number of data points to be skipped (Nth reading) or Averaged during recording. (Recommended Nth reading = 100). When the Blackbox tab is selected the Run, Pause and Stop buttons on the Tool Bar become enabled. Click on the Start button and data will begin to be collected and stored in the selected data file. The Sheet window will indicate a 111 and the Sample window will show the number of data points that are being accumulated under Sheet1. Click on the pause button and data accumulation will stop. Click on the pause button again and Sample count will start again from zero. The Sheet window will show a 121 indicating that data points are being accumulated under Sheet2. Each time data collection is paused and continued the sheet count will be advanced and the data will be stored in the selected file under the new sheet number. Click on the Stop button to end the data collection and close the file. Also, the Blackbox tab selected the Channel Bias button is enabled. This allows the zeroing of individual channels by high-lighting the channel name and clicking on the Channel Bias button.
6 Position-adjustment Panel

Manually positioning the carriage can be done conveniently from the Position-adjustment panel using the arrow keys. The carriage can be moved up or down fast by holding down the Alt. key and the up or down arrow key. The carriage can be moved at a slower rate by holding down the Ctrl. key and the up or down arrow key. The carriage will continue to move as long as the keys are held down. The slider can be moved in the same manner by using the left and right arrows. The velocities are set in the Options Menu under Carriage and Slider.

7 Options Menu (Hardware Configuration)

Use the Edit command in the Options menu to read or edit the hardware configuration file. The blue bar at the top of the window shows the name and the path of the loaded file. Other hardware configuration files can be saved using different names with the file extension .opt.

Generally the UMT system comes from the factory with the hardware options installed and the Options Menus already configured for the installed hardware. It is not necessary to change the contents of the Options menus unless hardware is added or changed.

7.1 Motorized Specimen

In the Motorized Specimen menu the boxes should be checked corresponding to the motorized positioning systems that are installed in the UMT as well as a heater.
7.1.1 Carriage

In the Carriage menu under Velocity(mm/sec) the values for Resolution and Maximum indicate the capability of the installed vertical positioning system for the upper specimen. They are there for information purposes only. The Initialization settings for Acceleration time and Deceleration time represent the maximum rate that will not cause stalling. The Fine Position Adjusting velocities are for the Position-adjustment panel described above.

7.1.1.1 Carriage Controller

The carriage motor/encoder has its own controller which is located inside the computer cabinet. In the Controller menu the resolution is specified in counts per micrometer, millimeter, inches, revolutions or cycles. When the Encoder Resolution is positive the downward direction of the carriage is positive. Because of this data plots of the carriage position (Z1) will go up as wear causes the carriage to move down. A negative sign before the encoder resolution will reverse the data plot. When the Use for Home Position box is checked the upper limit switch can be selected for use as the carriage Home Position. There is no Home Position sensor on the carriage, and the lower limit switch can not be reached under normal circumstances. A command to Move to Home Position in a test sequence will cause the carriage to move to the selected switch. If the Go Home at StartUp is checked the slider will move to the home position when the Graphs Panel or the Semi-automatic panel is selected. If the Zero Encoder box is checked the carriage position will be set to zero whenever the Home Position is reached.
The model of the controller is specified. Under **Controller Properties** the serial port is specified for the selected controller as well as the priority. Each motor controller has its own serial port. Priority for the Carriage controller usually has a higher priority setting than Spindle or Slider because the carriage must follow the variations in the lower specimen to maintain a constant force.

### 7.1.2 Spindle

In the **Spindle** menu the values for **Resolution** and **Maximum** under **Velocity(mm/sec)** indicate the capability of the installed rotary positioning system for the lower specimen. They are there for information purposes only. The value in the **Slow Range** window is the threshold which determines whether the controller will operate in the fast or slow range mode. The slow range is smoother than the fast range because there are more steps per revolution. In the fast range inertia provides the smoothing.

If a gear reduction or multiplication device is connected to the lower specimen positioning systems a check mark should appear in the **Reduction/Multiplication** box the reduction or multiplication ratio should appear in the **Ratio** window. The spindle speed is the motor speed divided by the Ratio.

The Initialization settings for Acceleration time and Deceleration time represent the maximum rate that will not cause stalling. In the automatic mode the test script overrides these settings.
7.1.3 Slider

In the Slider menu under Velocity (mm/sec) the values for Resolution and Maximum indicate the capability of the installed horizontal positioning system for the upper specimen. They are there for information purposes only. The Initialization settings for Acceleration time and Deceleration time represent the maximum rate that will not cause stalling. The Fine Position Adjusting velocities are for the Position-adjustment panel described above.

7.1.3.1 Slider Controller

The slider motor/encoder has its own controller which is located inside the computer cabinet. In the Controller menu the resolution is specified in counts per micrometer, millimeter, inches, revolutions or cycles. When the encoder resolution is positive the leftward direction of the slider is positive. When the Use for Home Position box is checked the Home Sensor, left limit switch, or right limit switch can be selected for used as the slider Home Position. The Home Sensor
is located at the center of the slider travel. A command to Move to Home Position in a test sequence will cause the slider to move to the selected switch. If the Go Home at StartUp is checked the slider will move to the home position when the Graphs Panel or the Semi-automatic panel is selected. If the Zero Encoder box is checked the carriage position will be set to zero whenever the Home Position is reached.

7.1.4 Heater
If the heater option is present the Controller Type will be entered at the factory as will the correct COM port and the limits for the temperature controller set points entered under Temperature Min Max. The Calibrating expression has not been implemented as of this writing. If there is no heater the Type should be Not Available. The Temperature Format can be set to whole degrees or tenths of degrees in Celsius or Fahrenheit.
7.2  Data Acquisition

The Data Acquisition Channels menu indicates which Analog Inputs are in use and allows for adding or deleting inputs. Fx and Fz are checked for a 2 dimensional force/load sensor. Analog Inputs 1, 2 and 3 may be used for options such as a Contact Acoustic Emission (AE) detector, an Electrical Contact Resistance sensor or for DC Voltage measurement.

![Data Acquisition Channels menu](image)

The settings for each channel include Name, Units of measure, plot color, Full scale value, scaling factor and offset. Software limits can be set to sound an alarm if one threshold is exceeded or abort a test stopping all motors if another threshold is exceeded. The polarity of the channel output can be reversed. When the Expression(s) box is checked C programming type expressions can be entered to modify the raw data from this channel.

![Data Acquisition Channels menu](image)

7.3  Graphs

The Graphs screen is used to set up the Automatic Panel display. Up to 9 different panels can be defined and displayed. Graphs can be added or deleted. Selecting New or an existing title brings up the display parameter screen. The title can be changed by entering the new name in the Title window. The value entered in the Filter Width window is the number of the data points that are averaged for each point.
displayed. If the **Start up automatically** box is checked the selected panel will be displayed when a test script is run.

The **Basic** graph is an X vs. Y type plot. In the **Y-axis** window the channels that are checked will be plotted in the selected panel. They include force, load, any measurement channel, coefficient of friction, carriage position, or slider position. Clicking on the **Defaults** button changes the title to the name of the checked box or boxes under **Y-axis**. The **X-axis** of the panel can be time, force, torque, any measurement channel, coefficient of friction, carriage position, or slider position. The x-axis and the y-axis are in the units that correspond to the selected channel. The x-axis and the y-axis **Min: and Max:** windows set the scale for each axis.
7.3.1 Color

The Automatic Panel Color screen sets the color of the plot and the corresponding legend for the channel selected in the Item window.

Also, see Automatic Panel elsewhere in this manual for more details.

7.4 Test Procedures

7.4.1 Script Interface

Most UMT applications use the UMT script interface. When Strain Test is selected and a new sequence is written it will have a different look.

The Spindle and Slider tabs do not appear, and the Strain Test tab appears in their place. A strain test results of the Strain Test are stored as a text (.txt) file. The file name is entered under Summary File Name.
8 Operator Panel

At the bottom of the Options Graphs screen are two buttons for changing the operating mode of the UMT software. The **Default interface** button requires a password and is used by CETR to configure the software for a particular user. The **Switch to Basic Mode** button requires a password to switch between Operator Mode and Engineering Mode. To switch from Engineering Mode to Operator Mode click on the **Switch to Basic Mode** button, enter the password in the dialog box and click OK, then click OK at the bottom of the Graphs window.

![Operator Panel Diagram]

When the operator mode is selected the Operator Panel appears. If the UMT program is exited in the operator mode it will be in the operator mode when it is restarted. The same is true for the engineering mode.

![Operator Panel Diagram]

The operator mode uses the settings and test scripts that were set up and saved in the engineering mode. Test scripts are selected by clicking on **Select** button which opens a file selection window. If the selected file has a description that was entered in the Sequence-Notes tab it will appear in the **Description** window.
Clicking on the **Start** button will open a data file entry window. After the name for the next data file is entered the selected test script will begin. The status window will go from Standby to Take Off as the carriage and slider move to the initial contact position. The status will then change to Test, and bar graph will indicate the progress. At the end of the test the status will change to Disengage as the carriage retracts and then to Standby.

After the completion of a test the operator may enter a comment in the **Operator Comments** window. When the **Save** button is clicked the comments will be stored with the data.

The **Abort** button may be used anytime during the test. The motors will stop and the data collected to that point will be saved. A message will appear indicating that the test was aborted by the operator.

Anything that stops the test before completion will cause a message to appear indicating what stopped the test such as a limit switch being reached, the light curtain interrupted, or the Emergency Stop button pressed.

The **Home** button is used to raise the carriage to its upper limit for changing the upper specimen.

**Carriage** and **Slider** windows at the bottom of the panel indicate their current position.

The Advanced button is used to switch to the engineering mode. It is password protected.

### 9 Analog Position Encoders

The optional analog encoder channels provide plots of the carriage (Sz), slider (Sx), and lower drive (Sr) position at a higher sampling rate than digital channels (Z1, Z3, and Z2 respectively). When each axis is moving continuously in one direction the plots will have a saw tooth shape. Each cycle represents one revolution of the drive motor. This is translated into microns for Sz and Sx and revolutions for Sr. When an axis such as the carriage (Sz) is moving about a small distance it is convenient to zero that channel to put the trace in the middle of the range and away from the min and max of the saw tooth. Sz, Sx, and Sr are set to zero simultaneously by clicking on the **Reset Encoders** button on the tool bar. The Reset Encoders button is enabled when the Semi-Automatic panel, the Graphs panel, or a test sequence is run. The analog encoders can be automatically zeroed during a test sequence. See **Carriage (Sheet Menu)**.
CETR

UMT-2
Multi-Specimen Test System

User's Manual

Version 1.00
2/24/04
1 UMT System Installation and Setup

*This section will cover system installation, setup and initial checkout*

1.1 Unpacking the system

On receipt, inspect the boxes for signs of mishandling. Note any damage on the bill of lading. Also note the condition of the Shock Watch and Tip-n-Tell indicators.

Open all the boxes and verify that the contents are undamaged. If any damage is found, immediately file a claim with the carrier (shipping company) for damages and notify CETR as to the type and extent of damage.

Check the contents of the boxes to verify that all ordered items have been received, all cables and adapters are present and all ordered options are installed or included. Notify CETR immediately of any discrepancies.

Remove the equipment from the box(es) and place on a level, solid table or workbench.

1.2 Connecting the System

Connect power cords to the computer, monitor and testing block.

Connect the display to the monitor connector on the back of the controller.

Connect the mouse and keyboard to their connectors on the back of the controller.

![UMT System Cable Connections Diagram]

COM1, COM2, and COM3 connectors should already have cables connected. These should be left as is. COM4 may also have a cable if it is a 4 drive system.
# Table of Contents

1 UMT System Installation and Setup ................................................................. 1

1.1 Unpacking the system ................................................................. 1

1.2 Connecting the System ................................................................. 1

1.3 Installing Components ................................................................. 2
   1.3.1 Friction/Load Sensor ................................................................. 2
   1.3.2 Lower Specimen Motorized Drives .................................................. 3
   1.3.3 Suspensions and Upper Specimen Holders ........................................ 5
   1.3.4 Additional Sensors ................................................................. 6

1.4 Preliminary Mechanical and Electrical Checkout ........................................ 6
   1.4.1 Drive check ................................................................. 6
   1.4.2 Instrument check ................................................................. 7

2 Test Procedure Examples ........................................................................ 10

2.1 Scratch aResistance ................................................................. 10

2.2 Block-on-Ring Testing .................................................................... 13

2.3 Ball on Flat Sliding Wear Test ............................................................ 15

2.4 Ball on Disk Sliding Wear .................................................................. 17

3 Calibration Procedures ........................................................................ 19

3.1 Force/load Sensor Calibration Procedure ................................................. 19

3.2 ECR Calibration Procedure ................................................................. 20

3.3 Contact Acoustic Emission (AE) Detector Mod.AE-5 Calibration ............. 21

3.4 Temperature Measurement/Recording Mod. TMR-150 Calibration ........... 22
Connect the cable that has 37 pin connectors on both ends to the matching connector on the back of the controller and the testing block. This cable is for motor control signals.

Connect the cable that has 25 pin connectors on both ends to the matching connector on the back of the controller and the testing block. This cable is for data acquisition.

1.3 Installing Components

1.3.1 Friction/Load Sensor

Several different Friction/Load Sensors varying in range and sensitivity may be purchased with the UMT system. The Friction/Load Sensor mounts either directly to the lateral positioning stage or to a 21 or 41 extension block which in turn mounts to the lateral positioning stage. A manually operated y-axis positioning stage may also be mounted to the lateral positioning stage. The sensor should be mounted with the connector on the left when friction force (Fx) is to be sensed from front to back such as pin on disk testing. When the slider is used to move the specimen
left and right against a stationary lower specimen the sensor should be mounted with the connector facing forward. Connect the flat cable from the left side of the Instrumentation Electronics Enclosure to the Friction/Load Sensor. In some cases it may be necessary to use an extension cable. Dual-beam sensors have threaded holes on the sensing surface for mounting suspensions and adapters.

1.3.1.1 Changing Friction/Load Sensors
When replacing a Friction/Load Sensor with one that has a different range, it is necessary to change the settings for both Fx and Fz in the Options file. The Scale should be set to full scale for the corresponding Units. The Warn threshold should be set to a level just below full scale, and the Abort threshold should be set to the full scale level.

1.3.2 Lower Specimen Motorized Drives
Several different Lower Specimen Motorized Drives may have been purchased with the UMT system varying in type of motion and torque rating. There are 3 types of rotational drives, a block-on-ring drive, and 2 types of reciprocating drives. All drives have a base which matches
the lower drive mounting ring located in the base of the testing block. Drives should be installed with the cables on the right so that they can be connected to the testing block connectors which are located in the lower right corner.

The reciprocating drive should be orientated with the specimen table in the front so that the motion is front to back.

The block-on-ring drive should be orientated with the shaft for the ring on the left.

Rotational Drive
A  Specimen Table
B  Specimen Mounting Holes
C  Drive Base
D  Power Connector

Reciprocating Drive

Block on Ring Drive

E  Block on Ring Shaft
F  Liquid/Grease Holder

1.3.2.1 Changing Lower Specimen Drives
When replacing a lower specimen drive with a different type it is necessary to change the settings in the Options file for RPM and encoder resolution.
The table below shows the settings for the different types of drives.

<table>
<thead>
<tr>
<th>Drive Model</th>
<th>Description</th>
<th>Max RPM</th>
<th>Reduction Ratio</th>
<th>Acc/Dec Time</th>
<th>Encoder Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLHHE</td>
<td>Ultra-Low Speed Rotation Motion</td>
<td>30</td>
<td>60</td>
<td>1 Sec.</td>
<td>240000</td>
</tr>
<tr>
<td>SHHME</td>
<td>Medium Torque Rotational Motion</td>
<td>5000</td>
<td>0.5</td>
<td>10 Sec.</td>
<td>8000</td>
</tr>
<tr>
<td>SHLLE</td>
<td>Low Torque Rotational Motion</td>
<td>5000</td>
<td>1</td>
<td>10 Sec.</td>
<td>4000</td>
</tr>
<tr>
<td>RHH</td>
<td>High-Load Linear Reciprocating</td>
<td>1800</td>
<td>1</td>
<td>1 Sec.</td>
<td>4000</td>
</tr>
<tr>
<td>RMH</td>
<td>Medium-Load Linear Reciprocating</td>
<td>1800</td>
<td>1</td>
<td>1 Sec.</td>
<td>4000</td>
</tr>
<tr>
<td>BHHM</td>
<td>Block-on-Ring</td>
<td>5000</td>
<td>0.5</td>
<td>10 Sec.</td>
<td>8000</td>
</tr>
</tbody>
</table>

1.3.3 Suspensions and Upper Specimen Holders

The suspension must have the same maximum load rating as the friction/load sensor that is installed. Sensors rated at 2 kg. or less have a square hole to accept the square shaft of the matching suspension. A screw on the front of the sensor is used to hold the suspension in place. Sensors rated at 5 kg. or more have a magnetic chuck to accept the matching suspension which in turn has a magnetic chuck for the specimen holder.

A screw on the front of the chuck may used to hold the suspension more firmly in place if needed.

There are many types of specimen holders available for holding balls, pins, needles, micro-cutting blades, etc. They are designed to match either the square hole suspension or the magnetic.
chuck. A holders with a square shaft can be used with a magnetic chuck by inserting it in a Collet Chuck which mates with a magnetic chuck.

Holder may be attached directly to the sensors without a suspension, although a suspension is recommended. In some cases a shaft extender may be required.

1.3.4 Additional Sensors

In addition to the friction /load sensors there may be other sensors used with the UMT such as Acoustic Emission (AE), temperature, and Electrical Contact Resistance (ECR). These sensors plug into their matching amplifiers located in the Instrumentation Electronics Enclosure. For example, the Acoustic Emission sensor cable plugs through the hole that is labeled iAEi on the front of the enclosure. There is a magnet on the end of the AE sensor for attachment to ferrous materials.

1.4 Preliminary Mechanical and Electrical Checkout

Verify all the connections to the units and power up the testing block, PC, and display.

Click on the UMT icon to display the main screen.

1.4.1 Drive check

This procedure performs a basic functional check of the drives. Click on the Semi-automatic Panel button on the Tool bar.

Click on the Carriage tab and enter the settings as shown.

Click on the Run button and the carriage should move down 10 mm in 10 seconds and stop. While the carriage is moving the green light should be lit and the red light off. Change the setting to Up and click on the Run button. The carriage should move up 10 mm in 10 seconds.

Click on the Spindle tab and enter the settings as shown.

Click on the Run button and the lower drive should rotate 1 turn clockwise in 6 seconds and stop. While the drive is moving the green light should be lit and the red light off. Change the setting to Counter Clockwise and click on the Run button. The drive should rotate 1 turn counterclockwise in 6 seconds and stop. If the lower drive is a reciprocating drive then 1 rotation of the drive will cause the specimen table to move 1 full stroke.

If your UMT has an upper rotational motion drive click on the Spindle II tab and perform the same test as above.
If your UMT has motorized lateral positioning click on the Slider tab and enter the settings as shown.

Click on the Run button and the slider should move left 10 mm in 10 seconds and stop. While the slider is moving the green light should be lit and the red light off. Change the setting to Right and click on the Run button. The slider should move right 10 mm in 10 seconds.

1.4.2 Instrument check
This procedure performs a basic functional check of the sensors. A suspension should be mounted to the sensor before doing the following test. Click on the Automatic Panel button on the Tool bar.

1.4.2.1 Force/Load Sensors
The screen that appears is displaying a real time plot of the force/load sensor output. The red trace displays the z-axis or loading force. The white trace displays the x-axis or friction force. Both traces should be close to zero on the y-axis.

Pulling downward on the suspension should move the red trace upward. Likewise, pushing up on the suspension should move the red trace downward.

Pulling forward on the suspension should move the white trace downward. Likewise, pushing back on the suspension should move the white trace upward.

If you do not get the above results check to make sure all connections are properly made. A large offset from zero or no response to pulling or pushing could indicate a damaged force/load sensor. In this case contact CETR Customer service at the number at the back of this manual.
1.4.2.2 Acoustic Emission Sensor

Click on the Automatic Panel button on the Tool bar again.

The above Edit Options screen will appear.

If your tester has the Contact Acoustic Emission (AE) option it will usually be connected to Input 1 and appear on the second panel as shown above. If AE has been assigned to a different panel then select that panel under Topics. Click on the OK button.

The screen that appears is displaying a real time plot of the AE sensor output. The trace should be close to zero on the y-axis.

Tap the AE sensor lightly against the body of the tester. Pulses should appear on the real time trace.

1.4.2.3 Electrical Contact Resistance Sensor

Click on the Automatic Panel button on the Tool bar again.
The above Edit Options screen will appear.

If your tester has the Electrical Contact Resistance (ECR) option it will usually be connected to Input 2 and appear on the third panel as shown above. In this example the model ECR-1K is installed. It measures resistance from 0 to 1000 ohms. If ECR has been assigned to a different panel then select that panel under **Topics**. Click on the **OK** button.

The screen that appears is displaying a real time plot of the ECR sensor output. The trace should be at the top when the leads are not connected to anything. When the leads are held together the trace should go to zero. If a resistor is available in the range from 100 to 900 ohms, or whatever range your ECR model can measure, connect the leads to each end of the resistor. The trace should be at the corresponding level on the y-axis.
2  Test Procedure Examples

2.1 Scratch fnResistance
Scratch Test Procedure and Its Application for a few µm thick DLC or Al₂O₃ on Steel Substrate.

Fig 2.1

Figure 2.1 Close-up view of Micro-blade set-up with Acoustic Sensor magnetically attached on the left side of the micro blade for evaluating disk coatings. Note the attack angle.

The schematic of the setup used in this study is shown in Figure 2.2. It can provide rotational, translational, or reciprocating motions with speeds ranging from 0.1 µm/s up to 10 m/s. The load is applied to the sample by the carriage using Fz for a close-loop feed-back mechanism for stability and accuracy, and can be kept constant or linearly increasing from as low as 0.5 mN (0.05 g) to as high as 200 N. Friction force (Fx), normal load (Fz), electric contact resistance (ECR) and acoustic emission (AE) are measured and recorded at a total sampling rate of 20k Hz. Wear depth, electric capacitance and digital camera are also readily available.

Fig. 2.2  Schematic of scratch test for thin and thick coatings with the Micro-Blade and multiple sensors.
The micro-blade was found as the most effective counter surface for accelerate wear tests for hard films, as compared to a ball or pin geometry. The advantage for using Micro-Blade is not limited to this, as it is also a very effective way to evaluate delaminating of film coatings. The reason for choosing the micro-blade was based on the contact stress analysis. For spherical or cylindrical contact geometry, the contact stress distributed well beyond a few nanometer (film thickness) deep. One really needs the contact stress concentrated within or near the surface film one wishes to study, not distributes well into the substrate/underlay, as the cases for ball or pin contact geometry.

Testing Procedures for Coating Durability

Hardware Configuration:

- 4 Mounting Block \# PN M30C116
- 2 Mounting Block \# PN M30C166
- Model DFL Dual Friction/Load Sensor
  - range 0.005 N to 0.5 N
- Holder for Micro-Cutting Blade
- Micro-Cutting Blade with 0.4mm Tip Radius
- Lower linear Reciprocating Motion Drive
  - mod. RMH
- Additional Sensors
  - mod AE-5 Acoustic Emissions Sensor
  - mod ECR-100K Electrical Contact Resistance

Testing Conditions:
Blade velocity: 167 \text{um/second}
Scratch Length: 10 mm
Scratch Duration: 60 Seconds

Measuring:
Friction force, Fx
Normal force, Fz
Electric Contact Resistance, ECR
Acoustic Emission, AE
Coefficient of Friction, COF

Software Test Setup:

UMT Options File:
Load the options file which contains settings for the Linear Reciprocating Motion drive and the 0.5 kg force/load sensor.
Test Sequence:
In this example the lower drive is stationary and is used as the specimen table. The slider is used to produce the scratch.

Sheet 1 is for setting time for the carriage to establish the initial normal load.
- **Carriage** - applies a \(5\) gram Constant Force for a Duration of \(10\) sec.
- **Spindle** - Velocity is \(0\) revs/min.
- **Slider** - \(\text{idle}\).

Sheet 2
- **Carriage** - applies a \(\text{n}5\) g to \(100\) g Linear Force\((Fz)\) by Time for a Duration of \(60\) sec.
- **Spindle** - Velocity is \(0\) revs/min
- **Slider** - Velocity (Working) is Automatic, Position is Increment, Offset is \(10\) mm, and Direction is Left

Data Collection:
The following should be checked under **DataFile**:
- \(Fx\) - Friction Force
- \(Fz\) - Normal Force
- \(T\) - Time
- \(Z1\) - Carriage Position (Used to determine Wear Depth)
- \(Z3\) - Slider Position
- \(ER\) - Electrical Resistance
- \(AE\) input - Acoustic Emission

Experimental Results:
In the scratch test, as the micro-blade moving slowly against the film coating, progressive materials removal occurred as exampled in Figure 2.3. In that figure, the corresponding measured friction force is \(Fx\) in red, normal force \(Fz\) in white, electric contact resistance \(ECR\) in yellow and acoustic emission \(AE\) in green as a function of testing time in seconds. Please note, the normal force increased with increasing testing time from 0 to 100 grams. In figure 3, the oxide coating film was progressively cut through by the micro-blade at about 22 seconds, corresponding to a critical load of about 40 grams. At this critical load, friction force was shifted to a higher value with a different slope. At exactly the same time, ECR dropped to practically zero, because the micro-blade made contact with the conductive magnetic film after cutting through the coating. Meanwhile, \(AE\) signal fluctuated much more strongly at the critical load.

Figure 2.3 below shows scratch test raw data for 3 um thick of \(Al_2O_3\) on steel substrate. The oxide film was scratched through at about 22 seconds, corresponding to a critical load of about 40 grams.
2.2 Block-on-Ring Testing

This test method covers the evaluation of wear and durability of lubricants and coatings under oscillating motion using a Block-on-Ring lower drive. A coated steel test ring (lower specimen) of a 35-mm diameter and 8.15-mm width is assembled on the tapered arbor of the Block-on-Ring drive. A steel test block (upper specimen) of 15.75-mm length and 6.35-mm width is held in the block holder. The ring is oscillated at a speed of 87.5± 1 cycle/min around its axis in a 90° arc. In the beginning of the test, the specimens are worn-in under a small load, the main test is performed under the test load. The main test includes friction force measurements during the test, and then evaluates the wear life as a number of cycles required for the frictional force to rise to a predetermined value. In-situ measurement of wear depth is taken, and the wear after the test is evaluated by measuring the width of a wear scar on the test block.

The UMT allows for monitoring during the test the actual dynamic normal load, friction force and friction coefficient, and depth of wear. Optionally, it can measure additional parameters of contact acoustic emission and temperature.
UMT Hardware Configuration:

- 4" Mounting Block " PN M30C116
- Model DFH-100 Dual Friction/Load Sensor
  - range 0.1 to 100 kg
- Upper Specimen Holder for Blocks
  - for sensors mod. DFH
- Upper Specimen Test Block
  - package of 5
- Lower Block-on-Ring Drive
  - mod. BHMM
- Lower Specimen Test Ring
  - package of 5
- Optional Additional Sensors
  - mod. AE-5 Contact Acoustic Emission Detector
  - mod. TMR-150 Temperature Measurement & Recording
  - mod. RTD Temperature Sensor

UMT Software Test Setup:

UMT Options File:
Load the options file which contains settings for the block-on-ring drive and the 100 kg force/load sensor.

Test Sequence:
The Test Sequence should consist of 3 sheets.
Sheet 1 is for settling time for the carriage to establish the initial normal load.
  *Carriage* - applies a 13 kg Constant Force for a Duration of 10 sec.
  *Spindle* Vel is 0 revs/min.
  *Slider* Vel is idle.

Sheet 2 is a 1-min wear-in period
  *Carriage* - applies a 13 kg Constant Force for a Duration of 1 min.
  *Spindle* Vel is 7.96 revs/min, Move- Increment, Distance 0.25 rev, and Direction- cycle
  *Slider* Vel is idle.

Sheet 3 is the wear-life test period
  *Carriage* - applies a 50 kg Constant Force for a Duration of 5 hours or as needed to achieve significant wear.
  *Spindle* Vel is 7.96 revs/min, Move- Increment, Distance 0.25 rev, and Direction- cycle.
  *Slider* Vel is idle.

Data Collection:
The following should be checked under DataFile:
  *Fx* Vel Friction Force
  *Fz* Vel Normal Force
  *T* Vel Time
  *Z1* Vel Carriage Position (Used to determine Wear Depth)
  *AE input* Vel Acoustic Emission (optional)
  *Te input* Vel Temperature (optional)

Report:

Use the Viewer program to plot test results.
Select the parameters to be displayed by checking the appropriate box under Parameters on the Viewer screen.
For viewing COF plots of reciprocating tests check the Fz box, click on the Symmetry button, click on the Peak Detect button, and then check the COF box. Multiple test results can be viewed at the same time as in the example below.

2.3 Ball on Flat Sliding Wear Test
This test method utilizes a ball upper specimen that slides against a flat lower specimen in a linear, back and forth sliding motion, under a prescribed set of conditions. The load is applied downward through the ball specimen against the flat specimen mounted on a reciprocating drive. The normal load, stroke length, frequency of oscillation, test temperature, lubricant, and test duration are listed below.

<table>
<thead>
<tr>
<th>Test Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lube</td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

Hardware Configuration:

- 4h Mounting Block & PN M30C116
- 2l Mounting Block & PN M30C166
- Model DFH-5 Dual Friction/Load Sensor
  - range 0.5 N to 50 N
- Suspension with Linear Guide-AM30C110D-1
- 3/8" Ball Holder AM30B310B
  - for sensors mod. DFH
- 3/8" Diameter Ball Specimen
- Lower linear Reciprocating Motion Drive
  - Manually adjust for 10 mm travel.
  - mod. RMH
- Optional Additional Sensors
  - mod. ECR-xx Electrical Contact Resistance
  - mod. TMR-150 Temperature Measurement & Recording
  - mod. RTD Temperature Sensor
Software Test Setup:

Options File:
Load the options file that contains settings for the Linear Reciprocating Motion drive and the 50 N force/load sensor.

Test Sequence:
The Test Sequence should consist of 2 sheets.

Sheet 1 is for settling time for the carriage to establish the initial normal load.
Carriage - applies a 25 N Constant Force for a Duration of 10 sec.
Spindle - Velocity is 0 revs/min.
Slider - is idle.

Sheet 2 is a 16 min. 40 sec. period
Carriage - applies a 25 N Constant Force for a Duration of 1000 seconds.
Spindle - Velocity is 300 revs/min, Move-Continuous, and Direction- Clockwise
Slider - is idle.

Data Collection:
The following should be checked under DataFile:
Fx - Friction Force
Fz - Normal Force
T - Time
Z1 - Carriage Position (Used to determine Wear Depth)
Te input - Temperature (optional)
AE - Acoustic Emission (optional)
EC - Electrical Contact Resistance (optional)

Report:

Use the Viewer program to plot test results.
Select the parameters to be displayed by checking the appropriate box under Parameters on the Viewer screen.
For viewing COF plots of reciprocating tests check the Fz box, click on the Symmetry button, click on the Peak Detect button, and then check the COF box.
2.4 Ball on Disk Sliding Wear
This test method involves a ball shaped upper specimen that slides against a rotating disk as a lower specimen under a prescribed set of conditions. The UMT allows for monitoring during the test the actual dynamic normal load, friction force and friction coefficient, and depth of wear. Optionally, it can measure additional parameters of contact acoustic emission, electrical contact resistance, and temperature. The configuration below is an example of one of many possible combinations of friction/load sensor, rotational drive, specimen holder, and specimens.

**Hardware Configuration:**

- 4" Mounting Block n PN M30C116
- Model DFH-2 Dual Friction/Load Sensor
  - range 0.2 N to 20 N
- Suspension with Linear Guide-AM30C110D-1
- 3/8" Ball Holder n AM30B310B
  - for sensors mod. DFH
- 440-C Stainless Steel Ball, Dia. 3/8" - PN BM110006
- Stainless Steel Disk
- Medium Torque Rotation Drive
  - Mod. SHHM
- Optional Additional Sensors
  - mod AE-5 Acoustic Emissions Sensor
  - mod ECR-xx Electrical Contact Resistance
  - mod. TMR-150 Temperature Measurement & Recording
  - mod. RTD Temperature Sensor

**Software Test Setup:**

Options File:
Load the options file that contains settings for the Medium Torque Rotational Motion Drive and the 20 N force/load sensor. Use the Semi-Automatic Mode to pre-position the x-axis slider so that the ball is 16 mm from the center of rotation of the lower specimen. This will create a circular wear track with a diameter of 32 mm.

Test Sequence:
The Test Sequence should consist of 2 sheets.

Sheet 1 is for settling time for the carriage to establish the initial normal load.

- **Carriage** - applies a 10 N *Constant Force* for a *Duration* of 10 sec.
- **Spindle** n *Velocity* is 0 revs/min.
- **Slider** n is *idle*.

Sheet 2 is a 16 min. 40 sec. period
- **Carriage** - applies a 10 N *Constant Force* for a *Duration* of 10000 seconds.
- **Spindle** n *Velocity* is 60 revs/min, Move-Continuous, and Direction- Clockwise
- **Slider** n is *idle*.
Data Collection:
The following should be checked under DataFile:
   Fx  Friction Force
   Fz  Normal Force
   T   Time
   Zl  Carriage Position (Used to determine Wear Depth)
   Te - input Temperature (optional)
   AE  Acoustic Emission (optional)
   EC  Electrical Contact Resistance

Report:

Use the Viewer program to plot test results.
Select the parameters to be displayed by checking
the appropriate boxes under Parameters on the Viewer screen.
3 Calibration Procedures

All sensors are factory calibrated, and an option file containing the calibration factors is created for each sensor. If that file is lost or corrupted the following methods may be used to restore the file.

3.1 Force/load Sensor Calibration Procedure

a. Disconnect the sensor cable and remove the sensor from the UMT-2, and reconnect it using the extension cable.

b. Install a holder capable of supporting the calibration weight to be used and place the sensor on a level, flat surface, holder side up.

c. Click on the Graphs Panel button. The Automatic Panel should appear displaying the default Fx and Fz.

d. Click on the Semi-Automatic Panel button. The Semi-Automatic Panel will appear. Select the Data-1 tab and click on the 1111 button to un-bias the sensor.

e. Adjust the Fz pot through the opening in the panel on the carriage to obtain a value of 0 for Fz as displayed at the right side of the Automatic Panel.

f. Place the calibration weight on the holder as shown below and note the reported value displayed at the right side of the Automatic Panel.

![Fz Weight Placement](image1)

![Fx Weight Placement](image2)

g. Calculate the calibration factor as shown here:

\[(SL \times AL)/MV = CF\]

Where SL = Sensor Limit, AL = Actual Load, MV = Measured Value and CF = Calibration Factor.

Do not use the (ft) when performing the calculations.
**Example:** In a UMT-2 with a 50N sensor where a 20N weight reports a value of -17.5N, the formula would be 
\[(50 \times 20) / 17.5 = 57.142\]

h. Close the Automatic Panel and go to **Options, Edit**, then select **Data Acquisition, Channels, Fz** and enter the calculated value in the **Scale** box. Click **Options, Save** to save the new values. Note: Scale should be 1 for standard 2-D (Fx and Fy) sensors and offset should be zero.

i. See the figure above for proper weight placement to adjust Fx.

j. Before attaching the weight, adjust the Fx pot for 0 N.

k. Repeat steps d through f to complete Fx calibration.

l. Repeat step g and enter the calculated value for Fx into the **Fx Scale** box. Click **Options, Save** to save the new values. Note: Scale should be 1 for standard 2-D (Fx and Fy) sensors and offset should be 0.

m. Install the sensor in the UMT-2.

n. Adjust the Fx and Fz pots for zero prior to starting a test.

3.2 ECR Calibration Procedure

The Electrical Contact Resistance (ECR) measurement modules come in the following ranges:

<table>
<thead>
<tr>
<th>Model</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECR-0.5</td>
<td>5 Ohm to 500mOhm</td>
</tr>
<tr>
<td>ECR-1</td>
<td>10mOhm to 1 Ohm</td>
</tr>
<tr>
<td>ECR-1K</td>
<td>10 Ohm to 1kOhm</td>
</tr>
<tr>
<td>ECR-100K</td>
<td>1kOhm to 100kOhm</td>
</tr>
<tr>
<td>ECR-1M</td>
<td>10kOhm to 1Mohm</td>
</tr>
</tbody>
</table>

Initially the scale setting in the options menu is set to the full scale value of the selected module. In the example below, the scale has been set to 1000 for the 10Ohm to 1kOhm module.
Click on the **Semi-Automatic Panel** button. The Semi-Automatic Panel will appear.

Select the Data-1 tab and click on the 1111 button to un-bias the sensor.

Click on the **Graphs Panel** button. The Automatic Panel should appear displaying the default Fx and Fz.

Click on the Graphs Panel button again. Select R1 and set the y-axis Max to 101% of full scale. Click on OK and the plot for R1 will appear. When there is nothing is connected between the ECR clip leads the trace will be at the top of the graph indicating infinite resistance. Clip the ERC leads together and the plot should go to zero. If it is slightly off adjust the R1 pot through the opening in the panel on the carriage to obtain a value of zero.

Connect a resistor that has a value that is near but less than full scale between the ECR leads. The value of the resistor should be measured beforehand by an independent means such as an Ohm meter.

Note the value on the R1 graph.

Calculate the calibration factor as shown here:

\[(SL*AR)/MV=CF\]


**Example:** In a UMT-2 with a 1 Kohm ECR sensor where a 960 ohm resistor reports a value of 850, the formula would be \((1000*960)/850=1129\).

Close the Automatic Panel and go to Options, Edit, then select Data Acquisition, Channels, R1 and enter the calculated value in the Scale box. Click Options, Save to save the new values.

### 3.3 Contact Acoustic Emission (AE) Detector Mod.AE-5 Calibration

There is no standard method for calibrating the AE detector such as weights or resistors. The AE detector is used for making comparative measurements such changes in AE due to changes in the surfaces of the specimen due to wear, or for comparing different specimens under the same conditions. The amplitude of the AE output will vary with the placement of the sensor.
and with the type of material being tested. The sensor should be attached to the upper specimen holder as close to the specimen as possible to achieve the highest output.

3.4 Temperature Measurement/Recording Mod. TMR-150 Calibration

Initially the scale setting in the options menu is set to the full scale value of 150°C.

Click on the **Semi-Automatic Panel** button. The Semi-Automatic Panel will appear.

Select the **Data-1** tab and click on the **1111** button to un-bias the sensor.

Click on the **Graphs Panel** button. The Automatic Panel should appear displaying the default Fx and Fz

Click on the Graphs Panel button again. Select **TE** and set the y-axis from 0 to 150. Click on **OK** and the plot for **TE** will appear. Place the RTD sensor in a heating chamber with a laboratory thermometer. Adjust the temperature of the chamber to 140°C. Allow enough time for the temperature to stabilize. Read the lab thermometer. Note the value on the **TE** graph. Calculate the calibration factor as shown here:

\[
\text{SL*AT)/MV=CF}
\]

Where **SL**=150, **AT**=Lab Thermometer Reading, **MV**=RTD Measured Value and **CF**=Calibration Factor.

Close the Automatic Panel and go to **Options, Edit**, then select **Data Acquisition, Channels, TE** and enter the calculated value in the **Scale** box Click **Options, Save** to save the new values.
CETR

UMT-2
Multi-Specimen Test System

*Viewer Manual*

*Version 2.12*
*Build 63*
*2/09/04*
Table of Contents

1 Overview ................................................................. 2
2 The Viewer Screen ...................................................... 2
  2.1 Menu Bar .......................................................... 2
     2.1.1 File .......................................................... 3
     2.1.2 Edit .......................................................... 3
     2.1.3 View .......................................................... 3
     2.1.4 Window ....................................................... 4
  2.2 Tool Bar ............................................................ 5
     2.2.1 Open ......................................................... 5
     2.2.2 Save Markers ............................................... 5
     2.2.3 Reread Test .................................................. 5
     2.2.4 Save Screen ............................................... 5
     2.2.5 Textify ....................................................... 5
     2.2.6 Copy ........................................................... 6
     2.2.7 Undo and Redo .............................................. 6
     2.2.8 Print Preview ............................................... 6
     2.2.9 Print ........................................................... 6
     2.2.10 Compress On/Off ........................................... 6
     2.2.11 Filter Factor ............................................... 6
     2.2.12 Filter ........................................................ 6
     2.2.13 Symmetry .................................................... 6
     2.2.14 Subtract Base .............................................. 7
     2.2.15 Peaks ........................................................ 7
     2.2.16 Compare Graph ............................................. 7
     2.2.17 Results Graph ............................................. 8
     2.2.18 Fast Fourier Transform (FFT) Graph ..................... 9
     2.2.19 Elastomer Graph ......................................... 11
     2.2.20 Indentation Graph ....................................... 12
     2.2.21 Comments .................................................. 13
     2.2.22 About ....................................................... 13
  2.3 Graph Parameters and Selections .............................. 13
     2.3.1 Constants ................................................... 13
     2.3.2 Tests .......................................................... 13
     2.3.3 X-Axis ........................................................ 14
     2.3.4 Parameters .................................................. 14
  2.4 Bottom Screen Windows ......................................... 15
     2.4.1 Average Value Window and graph markers .............. 15
     2.4.2 Std ............................................................ 16
     2.4.3 Current Value ............................................... 16
     2.4.4 Y-Axis Scaling .............................................. 16
     2.4.5 X-Axis Scaling .............................................. 16
1 Overview
The Viewer (sometimes referred to as iBlackboxj) program translates the UMT data files into graphical displays for analysis and presentation. In the UMT testing software a test is written as a script, which is composed of a series of sequences. Each sequence in the script generates its own data file. Sequences are composed of one or more sheets, which define the mechanical action of the UMT Testing Block. The data in the files can be sorted by the sheet and by parameter or data channel such as load force or friction.

2 The Viewer Screen
The illustration below shows the various components of the viewer screen. The top bar shows the name of the file being displayed. On the right under Tests the selected sheet is highlighted. Under Parameters the selected channel is checked in this case Fx (horizontal force). This plot represents force in Newtons in the y-axis versus Time in seconds in the x-axis.

![Viewer Screen Diagram]

2.1 Menu Bar
After a test file is opened and displayed the menu bar appears as above with the addition of Edit and Window menu options (which are absent originally when a program starts).
2.1.1 File
The File menu is similar to most windows applications with two exceptions. There is no New command because the viewer is for looking at existing files. There is a Textify Files command for converting data files into ASCII format for importing to spreadsheet programs. If markers are added to the Viewer plot they can be saved with the data using the Save Markers command. A file can be opened as one continuous sheet instead of the actual number of separate sheets in the test sequence. Multiple files can be opened in the same window and plots will be appended end to end.

2.1.2 Edit
Copy or Ctrl +C or \text{copy} copies the displayed plot to the clipboard. By using a paint program the clipboard can be pasted to a screen. Additional labels and text can then be added and the result saved as a bitmap file.

2.1.3 View
The View menu has number of commands that also have shortcut keys and Tool Bar buttons.
Filter or Ctrl +F or \text{filter} performs a running average of the data points. The number of points to be averaged is entered in the window to the left of the Filter button in the Tool Bar.
Symmetry Graph or Ctrl +M or \text{symmetry} shifts the plot equally about zero on the y axis.
Subtract Base or Ctrl +B or \text{subtract} displays the following dialog box.

\begin{center}
\begin{tabular}{c}
\text{Enter Value} \\
\text{Subtract from Graph:} \\
\text{OK} \\
\text{Cancel}
\end{tabular}
\end{center}

\text{The value entered in the window will be subtracted from the plot causing the plot to shift in the y axis by an equal and opposite amount.}

Peaks or Ctrl +K or \text{peaks} displays the following dialog box.

\begin{center}
\begin{tabular}{c}
\text{Peaks parameters} \\
\text{Samples in the box:} \hspace{1cm} 100 \\
\text{Top percent:} \hspace{1cm} 0.1 \\
\text{OK} \\
\text{Cancel}
\end{tabular}
\end{center}

\text{In this example average value of the highest 10\% in each group of 100 data points will be plotted. The resulting graph is a plot that follows the peaks of the data.}

Reread Tests or Ctrl +T or \text{reread} reloads the currently displayed plot with all its modifications such as symmetry. This is useful for updating plots when viewing with the test is in progress.
Tool Bar and Status Bar will appear on the screen when checked.

Colors/Options ñ Graph colors and fonts may be changed from the default setting for each plot and its corresponding y-axis scale.

2.1.4 Window

See Result Window below. Comments opens saved comments window. New Window places additional plot windows on the screen. Cascade overlaps multiple plot windows. Tile places multiple plot windows side by side. Arrange Icons

Open test files are listed. A check selects the file to be displayed.
2.2 Tool Bar

2.2.1 Open
This is a standard Windows button for opening files. It is the same as Open in the File menu. It will display a directory of data files with the .tst extension. Files must be opened one at a time, however, more than one file may be open at a time. All files that are currently open are listed under the Window menu.

2.2.2 Save Markers
Markers can be added to the graph using the right mouse key. These markers can be saved with the data by clicking this button.

2.2.3 Rereread Test
This reloads the currently selected sheet as is. Various buttons on the Tool Bar such as Filter alter the appearance of the plot. To restore the plot to the unaltered state, reopen the file. Reread Test is used to update plots when viewing while the test is still running.

2.2.4 Save Screen
An ASCII text file is created with only the parameters that checked and plotted on the screen.

2.2.5 Textify
Data files are in binary format. Textify will create an ASCII text version of the file for importing to spreadsheet programs. The new file will have the same name but with a .txt extension. The data from the original file can be modified to reduce the number of points. When No Filter is selected all data points are included. When Skip is selected nth data point is included were n is the number in the window when Define Number of Points is not checked. This reduces the total number of data points by a factor of n. When Define Number of Points is checked the total number of data points will equal the number in the window. When Average is selected the average of successive groups of n data points is taken were n is the number in the window when Define Number of Points is not checked. This
reduces the total number of data points by a factor of n. When **Moving Average** is selected the sliding average of groups of n data points is taken. This does not reduce the number of data points, but it smooths the data. When **Open all data in a single sheet** is checked all of the data from the beginning of the test sequence to the end of the last sheet is combined into one sheet. This will include data recorded during the Engage portion of the sequence.

The textified file can be further reduced by selecting only the sheet or sheets or the time interval to be copied. For example, if sheet 1 of a sequence is for settling of the applied load and the data is not important, it can be skipped by selecting only sheet 2.

### 2.2.6 Copy
Copy saves the displayed plot to the clipboard. By using a Paint program the clipboard can be pasted to a screen. Additional labels and text can then be added and the result saved as a bit map file.

### 2.2.7 Undo and Redo
Undo list the most resent changes to the plot. Selecting an item from the list will undo that change. Redo list the most resent undo changes. Selecting an item from the list will restore that change.

### 2.2.8 Print Preview
Print Preview shows how the plot will look when printed.

### 2.2.9 Print
Send plot to printer.

### 2.2.10 Compress On/Off
Data files may have many data points representing a long period of time. With Compress On the full time period is displayed. Compress Off is used to see detailed portions of the plot. A scroll bar at the bottom of the plot screen allows you to scroll through the entire plot while viewing a small segment of the plot.

### 2.2.11 Filter Factor
The number entered in this window is the number of data points used to take a running average of the plot. The larger the number is the smoother is the plot.

### 2.2.12 Filter
The Filter button applies the Filter Factor to the plot each time it is clicked. The more it is clicked the smoother the plot. To restore the plot to unfiltered reopen the data file.

### 2.2.13 Symmetry
Symmetry adjusts the plot equally about zero on the y axis.
2.2.14 Subtract Base
The Subtract Base button displays the following dialog box.

Enter Value: [Blank Window]

<table>
<thead>
<tr>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
</table>

Subtractct from Graph: [Blank Window]

The value entered in the window will be subtracted from the plot causing the plot to shift in the y axis by an equal and opposite amount.

2.2.15 Peaks
The Peaks button displays the following dialog box.

Peaks parameters: [Blank Window]

<table>
<thead>
<tr>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
</table>

Samples in the box: [100]
Top percent: [0.1]

In this example average value of the highest 10% in each group of 100 data points will be plotted. The resulting graph is a plot that follows the peaks of the data.

2.2.16 Compare Graph
The results of separate tests can be plotted on the same screen. Go to File and Open the data files that you wish to compare, and then click on the Compare Graph button. All the selected files will be plotted. To remove one or more of the overlapping plots click on the file name in the window on the right then uncheck the box next to the unwanted sheet.
2.2.17 Results Graph
Results Graph plots the coefficient of friction as a function of the parameters selected at the bottom of the screen. In the case below the coefficient of friction is calculated from the z or load force and the y axis friction force. It is plotted along the x axis as a function of velocity in rpm. The test script from which this data was captured had 10 tests or sheets, therefore there are 10 data points. (Two points nearly overlap at 0.25 and 0.5 rpm.)

To eliminate unwanted data points, such as the first test at 0 rpm, double click on the test name in the lower right box to expand the list to show all the test steps. Remove unwanted steps by clicking on the check box to remove the check mark.
2.2.18 Fast Fourier Transform (FFT) Graph
A Fast Fourier Transform takes a data stream that represents amplitude vs. time and plots it as amplitude vs. frequency. The amplitude of every particular harmonic is characterized with a module value, the square of which is plotted vs. the corresponding frequency value (in Hz). The highest frequency FFT can represent theoretically is called Nyquist Frequency\(^\dagger\) and can be calculated as:

\[
F_N = \frac{1}{2\tau}
\]

where \(\tau\) is a time interval between the samples in the original time series. In fact this means that the Nyquist Frequency equals the half of the sampling rate of the original time series.

For practical purposes it is recommended to rely only on FFT values at the frequencies at least 3 to 5 times lower than Nyquist Frequency.

The FFT procedure applied to a time series without any additional data processing results in so-called Periodogram.

To receive more stable results it is recommended to calculate Power Spectral Density (PSD) of the time series. PSD is nothing more than averaged Periodogram. It is calculated via breaking the original time series into equal pieces, or partitions, performing FFT on each, and averaging the results. It is also recommended for the sake of robustness not to reduce the number of partitions below 16, since it makes PSD calculation unreasonable (the less points each partition contains, the less points will the target FFT have, resulting in a lose of the PSD frequency resolution).

There are two commonly used approaches to how the original time series should be partitioned:
- contiguous, and
- overlapped

With the first approach each sequential partition starts at the sample next to where the previous partition ended, while using the second approach means starting each partition (except the first) exactly at the middle of the previous partition.

There is one more sort of data processing commonly used along with the FFT in order to reduce the distortions due to the limited length of the data series. It is called data windowing\(^\dagger\). According to this procedure the original data are passed through a special filter (time window) before FFT itself, which smoothes the data at the partition ends. There are many types of data windows, which are used by researchers: Bartlett, Hann, Hamming, etc.

All the above-described features are implemented in the described viewer software. In order to perform the FFT of a currently selected parameter such as friction force (Fx), click on the FFT button on the toolbar.

The new window will be opened with controls allowing to calculate/view FFT using various options. A plot of amplitude vs. frequency will be displayed.
When the Periodogram box is not checked, the PSD is calculated by the selected Data Window Type, i.e. Bartlett, Hann, Welch. As mentioned above, the larger the Partition Size the higher the resolution. When the Overlap box is checked the partitions overlap as described above, otherwise the partitions are contiguous.

When the Automatic box is checked the x and y scale are set automatically. Unchecking the box allows manual scaling.

In order to prevent long calculation delays, which are the case when a long time series is being processed, there is also an option in the Main Menu under View-Colors/Options, which turns the FFT automatic recalculation off. In this case to recalculate the FFT with new options the Recalculate button should be pressed.

When the cursor is pointing to a place on the plot the values of the x-axis and y-axis at the tip of the arrow are displayed. When the cursor is below the x axis the y value of the plot corresponding to the x-axis position of the cursor is displayed.
2.2.19 Elastomer Graph

The UMT can test the viscoelastic properties of elastomers by applying a sinusoidal force (Fz) of a given amplitude and frequency to an elastomers specimen of a given geometry while recording the force and the displacement as measured with the optional analog output of the z-axis encoder (Sz). The resultant plot is shown below. Using the right-hand mouse button place a marker (yellow) on a peak of either plot and a second marker (green) on a later peak of the same plot.

Click on the Elastomer Graph button on the Tool Bar, and a plot of an elliptical shape should appear. Select the Test Type (Shear or Compression), Sample Form (Cylindrical or Square), Number of Samples (1 or 2), and enter the Diameter and Length of the sample. The number of samples is 1 when a single sample is compressed, or 2 when 2 samples are sandwiched together and the shear force is applied between them.
To complete the calculation for compression tests it is necessary to enter the Mean Length of the sample at the bottom center of the screen. Click on the Calculate button after all the parameters have been entered. The results appear on the right of the screen. Click on the Printer button on the Tool bar to print the plot and the calculation results.

2.2.20 Indentation Graph

The Indentation Graph is intended to be used only with data recorded during an indentation test on the UMT. A typical indentation test consists of 4 sheets. During the first sheet the indenter applies a constant low force (i.e. 1% of maximum indentation force) against the test material for 10 to 20 seconds. This establishes the zero displacement reference and can be used for temperature drift calculations. The second sheet of the test ramps up the indenting force to a high value (i.e. 500 N) at a linear rate over 30 seconds. The third sheet maintains that force for some time (i.e. 10 to 20 seconds). The forth sheet ramps the indenting force down to near zero force at a linear rate. Fz, Z1 carriage displacement, and any additional displacement channel, such as a capacitance probe, should be recorded. It is preferable to name the additional displacement channel C1.

After opening the indenter data file with the Viewer program select Fz for the y-axis parameter. Select the displacement channel for the x-axis, and select test 4 (sheet 4). Click on the Temperature drift button. This will get temperature drift information from test 1 regardless of which test is currently displayed. Click on the Indentation Graph button and the Indentation Graph will appear. If the x-axis was not changed from time to displacement the software automatically will look for C1 and use it for the x-axis. If C1 can not be found it will use Z for the x-axis.
The graph shows force vs. displacement. In the lower left corner of the screen the Scale can be automatic or set manually. Next to Scale are windows indicating the x and y values at the tip of the cursor. Next are the windows for the selection of Indenter type and shape and the Poisson Ratio. It is the users responsibility to make the proper entries. The % Fit windows allow the selection of the portion of the plot to be used for calculations. After changing these values it is necessary to click on the Calculate button to get a new calculation. Results appear to the right of the plot.

2.2.21 Comments
When a test is completed the operator can add comments, which are stored with the data. The Envelope icon will be illuminated on the Viewer tool bar when the selected data file has a comment attached. Clicking on the Comments button will display the comments.

2.2.22 About
The About button displays the Viewer software version. This is a shortcut to the same information under Help.

2.3 Graph Parameters and Selections

2.3.1 Constants

<table>
<thead>
<tr>
<th>Constants</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>R [mm]</td>
<td>14.5</td>
</tr>
<tr>
<td>Load [N]</td>
<td>40</td>
</tr>
<tr>
<td>V [rpm]</td>
<td>10</td>
</tr>
<tr>
<td>V [mm/min]</td>
<td></td>
</tr>
<tr>
<td>V [in/min]</td>
<td></td>
</tr>
</tbody>
</table>

This window displays certain constants pertaining to the selected test (the high-lighted sheet in the Tests window). In this example the test was done with a loading force of 40N at a radius of 14.5 mm on a disk rotating at 10 rpm.

2.3.2 Tests

<table>
<thead>
<tr>
<th>Tests</th>
<th>Time Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fz = 15 N 10.03 sec</td>
<td></td>
</tr>
<tr>
<td>Fz = 15 N 10.07 sec</td>
<td></td>
</tr>
</tbody>
</table>

Each test in the list was a sheet in a sequence in a test script. The loading force in Newtons and the duration in seconds make up the name of the test. Multiple windows can be displayed. See Window menu ñ New Window above.
2.3.3 X-Axis

The X-Axis can represent time or any other recorded parameter such as the X direction displacement.

2.3.4 Parameters

Each test captures data from multiple channels. The channel to be plotted for the selected test is selected from the Parameters list. More that one parameter can be plotted at the same time.

In the example below the first test is selected, and you can see that it was performed at 0 rpm. Next the second test is selected, and you can see that it was performed at 60 rpm. Compare this with the Results Graph above. The first data point is at 0 rpm and the second data point is at 60 rpm. The next 8 tests were performed while decreasing the rpm.

The first test was performed at 20 mm radius, 50 N load, and 0 rpm. The Time Span was 6.07 seconds.
The second test was performed at 20 mm radius, 50 N load, and 50 rpm. The Time Span was 11.08 seconds.

2.4 Bottom Screen Windows
The windows at the bottom of the graphs display data values and axis scaling controls.

2.4.1 Average Value Window and graph markers
This window displays the average value of the selected parameter. If no markers are inserted the value will be for the entire plot. **X-axis markers** can be inserted in a plot where the x-axis is time. Position the cursor at a point at the beginning of the graph segment that is to be averaged and click on the right mouse button. A yellow line appears. Move the cursor to a point at the end of the segment that is to be averaged and click the right mouse button. A green line appears. The average value window displays the average value between the markers. A total of 3 pairs of markers can be inserted. Only the average from the first pair will be displayed. Markers can be deleted by placing the cursor on the marker and clicking the right mouse button (Green before yellow). To change the parameter being averaged click on desired parameter in the Parameter window on the right side of the screen. **A horizontal marker** can be inserted in the plot by
positioning the cursor to the left of the Y-axis and clicking on the right mouse button. A red line appears. Moving the cursor to a parameter in the parameter window will display values for that parameter representing the energy in Newtons per second of the plot above the marker and below the marker.

2.4.2 Std
The Standard Deviation for the entire plot or for the segment between the markers is displayed in the Std window for the selected parameter. To change the parameter click on desired parameter in the Parameter window on the right side of the screen.

2.4.3 Current Value
The y-axis value at the tip of the arrow cursor is continuously displayed for the selected parameter. To change the parameter click on desired parameter in the Parameter window on the right side of the screen.

2.4.4 Y-Axis Scaling
The y-axis can be scaled automatically by checking Automatic Scale box, or the minimum and maximum can be set manually.

2.4.5 X-Axis Scaling
The x-axis can be scaled automatically by checking Auto X range box, or it can be set manually. When the range that is less than full scale is set manually a slide box appears at the bottom of the plot. This enables you to scan the entire range a small segment at a time.